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Capitolo 1

Introduzione

Nell’ambito della robotica è fondamentale poter simulare i robot e l’ambiente

con cui entrano in contatto, cos̀ı da poter testare in sicurezza nuove funzio-

nalità o modifiche prima di applicarle al robot reale. Per questo è necessario

disporre di un ambiente di simulazione robusto che sia in grado di modellare

nel modo più fedele possibile i robot, il loro comportamento e gli ambienti in

cui operano.

Sono presenti sul mercato diversi software per simulazioni robotiche, tra i

quali compare Unity, un popolare motore grafico utilizzato anche nell’ambito

della robotica.

L’obiettivo principale di questo lavoro è analizzare gli strumenti che Uni-

ty mette a disposizione per creare simulazioni robotiche, in modo da com-

prenderne le potenzialità ed i limiti. Sono di particolare interesse i seguenti

fattori:

• l’integrazione del simulatore con il framework ROS 2 (la seconda versio-

ne del Robot Operating System (ROS)) e di conseguenza con il midd-

leware DDS, utilizzato da ROS 2 per la comunicazione tra componenti;

• la semplicità di realizzazione di nuovi scenari di simulazione;

• la varietà di sensori disponibili e la semplicità di creazione di nuovi

sensori;

• l’accuratezza della simulazione.
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CAPITOLO 1. INTRODUZIONE

Per valutare questi aspetti è stata realizzata una simulazione in Unity di un

semplice robot mobile su due ruote, attraverso la quale sono state sperimen-

tate le varie opzioni e funzionalità messe a disposizione dal simulatore.

Questo lavoro è anche utile come introduzione e guida all’utilizzo di Unity

come strumento per la simulazione robotica, soprattutto per quanto riguarda

robot mobili su due ruote.
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Capitolo 2

Tecnologie utilizzate

Il lavoro è stato svolto sul sistema operativo Ubuntu 20.04 LTS Focal Fossa.

Il software di simulazione utilizzato è Unity, che implementa meccanismi di

comunicazione basati su ROS 2. ROS 2 è un framework open-source per lo

sviluppo di applicazioni legate alla robotica che utilizza come middleware lo

standard DDS. Per far comunicare una simulazione Unity con componenti

esterne al simulatore è stato utilizzato sia ROS 2 che eProsima Fast DDS

2.2.0, un’implementazione in C++ dello standard DDS.

2.1 Unity

Sviluppato e mantenuto da Unity Technologies a partire dal 2005, Unity

è un motore grafico, o game engine, multipiattaforma. Un motore grafico

è un framework che comprende diversi componenti software fondamentali

per lo sviluppo di videogiochi, come il motore fisico, o physics engine, un

ambiente di sviluppo grafico e diverse librerie che ne facilitano e ottimizzano

lo sviluppo.

È attualmente utilizzato a livello internazionale principalmente per lo

sviluppo di videogiochi ma si presta anche allo sviluppo di contenuti multi-

mediali non appartenenti al mondo videoludico, quali visualizzazioni archi-

tettoniche e la produzione di film. Unity Technologies ha anche investito

nell’ambito della simulazione robotica, espandendo il già vasto universo le-
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CAPITOLO 2. TECNOLOGIE UTILIZZATE

gato al motore grafico con plug-in, tutorial e materiale per la simulazione di

robot.

Unity permette di sviluppare applicazioni sia in due dimensioni (2D) che

in tre dimensioni (3D), nel primo caso il motore fisico utilizzato è Box2D,

nel secondo Nvidia PhysX. Sono questi componenti software che si occupano

di simulare la fisica all’interno di quello che è, in questo caso, l’ambiente di

simulazione. I physics engine si occupano quindi di gestire interazioni come

collisioni, accelerazioni e gravità.

Unity mette a disposizione l’applicazione Unity Hub, dalla quale è pos-

sibile accedere all’ecosistema di Unity, permette infatti di gestire i progetti

Unity e di installare e gestire le versioni dell’Editor, cioè l’ambiente grafico

di sviluppo che consente la gestione di tutti gli aspetti della simulazione.

Un progetto in Unity è una collezione di cartelle e file. Tra questi file sono

fondamentali quelli con estensione unity, che descrivono le scene. Per lavora-

re in Unity è necessario creare una scena. Una scena è un insieme di oggetti,

chiamati GameObject. Un GameObject è un “contenitore” di component. I

component sono gli elementi che implementano le funzionalità dell’oggetto,

come le collisioni con altri oggetti o la forma dell’oggetto stesso. L’Editor

mette a disposizione, oltre all’oggetto vuoto, ovvero privo di component, altri

oggetti con alcuni component già aggiunti, come il cubo, il piano e la camera.

Gli oggetti possono essere organizzati in una struttura gerarchica, ad esempio

un robot può essere costituito da una gerarchia di oggetti in cui compaiono,

tra gli altri, i sensori e le ruote. Ogni GameObject è caratterizzato dalla

sua Transform, ovvero tre triplette (X, Y e Z) di informazioni riguardanti la

posizione (Position), la rotazione (Rotation) e le dimensioni (Scale) dell’og-

getto stesso. La posizione e la rotazione sono relative all’oggetto padre nella

gerarchia. Nel caso in cui l’oggetto non abbia un padre, le informazioni di

Transform sono relative al centro della scena.

I component possono anche essere degli script. Gli script vengono utiliz-

zati sia per far interagire i vari oggetti tra di loro all’interno della scena, sia

per far comunicare Unity con l’esterno. Unity supporta nativamente due lin-

guaggi di programmazione: C# e UnityScript. Quest’ultimo è un linguaggio

progettato specificamente per Unity ed influenzato da JavaScript. Per que-
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CAPITOLO 2. TECNOLOGIE UTILIZZATE

sto lavoro è stato utilizzato C#. Ogni script C# in Unity implementa una

classe che eredita dalla classe base definita all’interno di Unity chiamata Mo-

noBehaviour. Questa prevede metodi fondamentali come Start(), chiamato

quando lo script viene abilitato, e Update(), chiamato ad ogni frame.

I file utilizzabili nel progetto sono contenuti nella cartella Assets, che può

essere esplorata direttamente attraverso l’Editor, nella finestra Project.

Nella Figura 2.1 si vede un esempio di una scena nell’Editor di Unity,

si noti la gerarchia degli oggetti, chiamata Hierarchy, sul lato sinistro del-

l’Editor. Nella finestra sulla destra, chiamata Inspector, si trovano invece

le informazioni relative a Transform e i component relativi al GameObject

Cube, tra i quali si individua uno script C#.

Figura 2.1: Esempio di una scena nell’Editor Unity

2.2 ROS 2

Robot Operating System (ROS) è un insieme di librerie e strumenti open

source per lo sviluppo di applicazioni legate al mondo della robotica rilasciato

per la prima volta nel 2007. Successivamente, nel 2017, è stata rilasciata

5



CAPITOLO 2. TECNOLOGIE UTILIZZATE

la seconda versione di ROS, ovvero ROS 2, che introduce diverse migliorie

volte ad adeguarsi ai cambiamenti avvenuti nell’ambito della robotica. Unity

fornisce strumenti per la comunicazione sia con ROS che con ROS 2. Per

questo lavoro si è utilizzato solamente ROS 2, in particolare la distribuzione

Foxy Fitzroy [2]. Gli aspetti fondamentali di ROS 2 vengono descritti di

seguito.

Un sistema robotico basato su ROS 2 è composto da diversi nodi, ovvero

processi computazionali in grado di comunicare tra loro. Ogni nodo del

sistema è, o almeno dovrebbe essere, responsabile di un particolare compito,

come ad esempio il controllo delle ruote del robot o la gestione di un sensore

laser. In ROS 2 un singolo eseguibile può contenere più nodi. Per poter

scrivere programmi che implementano nodi ROS 2 è necessario utilizzare

delle apposite API (chiamate client libraries), disponibili in diversi linguaggi

di programmazione. Le uniche client libraries sviluppate direttamente dal

team di ROS 2 sono rclcpp (per codice C++) e rclpy (per codice Python),

le altre sono scritte dalla community di ROS 2. Diversi nodi scritti con

linguaggi differenti possono comunque comunicare tra loro.

I nodi possono scambiare dati attraverso tre meccanismi:

• topic: i dati vengono scambiati attraverso il paradigma di comunica-

zione publisher-subscriber;

• servizi: la comunicazione è basata sul modello call-and-response;

• azioni: il concetto è simile a quello dei servizi, ma più articolato, ven-

gono sfruttati infatti sia i servizi che i topic. Un nodo “action client”

invia un goal ad un nodo “action server”, che lo riconosce. Successi-

vamente il nodo “action server” invia, attraverso un topic, uno stream

di dati di feedback. Infine, il risultato viene inviato da “action server”

verso “action client”.

Inoltre, ROS 2 introduce il concetto di parametri, ovvero valori relativi a

ciascun nodo utilizzati per configurare il nodo stesso durante l’inizializzazione

o a runtime, senza modificarne il codice.
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CAPITOLO 2. TECNOLOGIE UTILIZZATE

In questo lavoro è stato utilizzato solamente il meccanismo dei topic,

rappresentato nella Figura 2.2, che viene quindi descritto più nel dettaglio.

Ciascun nodo può pubblicare e ricevere messaggi su un qualsiasi numero di

Figura 2.2: Esempio di comunicazione in ROS 2 tramite topic

topic. Per ricevere messaggi su un topic è necessario che il nodo abbia at-

tiva un’entità subscriber. Analogamente, per inviare messaggi è necessaria

un’entità publisher. I nodi che hanno attivo un subscriber di un determinato

topic riceveranno tutti i messaggi inviati da un qualsiasi publisher che abbia

pubblicato su tale topic. Ciascun topic è caratterizzato da un nome e da un

tipo (topic type). Il tipo non è altro che la struttura dei dati contenuti nei

messaggi scambiati sul topic. Per poter comunicare correttamente, tutti i

publisher e subscriber di un dato topic devono utilizzare lo stesso topic type.

ROS 2 mette a disposizione diversi tipi di messaggi per i casi più frequenti,

ma si possono comunque definire tipi personalizzati se necessario. La comun-

cazione tramite topic sfrutta anche il concetto di QoS. I Quality of Service

(QoS) sono dei parametri configurabili che controllano le caratteristiche della

comunicazione. Un esempio è Reliability, che può essere impostato a Best

effort o Reliable. Nel primo caso il messaggio potrebbe andare perso, nel
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CAPITOLO 2. TECNOLOGIE UTILIZZATE

secondo è garantito che il messaggio venga trasmesso, se necessario provando

più volte. Ciascun publisher o subscriber può impostare i propri QoS, ma

per far s̀ı che la comunicazione avvenga con successo essi devono essere com-

patibili, ovvero i QoS del subscriber devono essere uguali o meno “stringenti”

di quelli del publisher. Per esempio nel caso di Reliability la compatibilità è

la seguente:

Publisher Subscriber Compatibilità

Best effort Best effort S̀ı

Best effort Reliable No

Reliable Best effort S̀ı

Reliable Reliable S̀ı

ROS 2 mette a disposizione anche un framework per interfaccia grafica,

chiamato rqt, che implementa diversi tool ed interfaccie sotto forma di plugin.

Ad esempio il plugin rqt graph permette di visualizzare un grafico contenente

tutti i nodi, i topic e le connessioni tra di essi attivi nel sistema.

Un altro tool disponibile per ROS 2 è rviz2, il quale permette di vi-

sualizzare, se possibile, i messaggi pubblicati sui topic sotto forma grafica

in un ambiente tridimensionale. Permette anche di pubblicare messaggi su

determinati topic.

2.3 eProsima Fast DDS

eProsima fast DDS è un’implementazione C++ dello standard DDS (Da-

ta Distribution Service), emanato dall’Object Management Group (OMG).

DDS definisce un middleware per comunicazione di tipo publisher-subscriber

rivolto a sitemi real-time ed embedded. In particolare, eProsima fast DDS è

stato scelto come middleware di deafult di ROS 2. Per questo lavoro è stata

utilizzata la versione 2.2.0 di eProsima Fast DDS [4].

La comunicazione attraverso eProsima Fast DDS è molto simile a quella

descritta per il meccanismo dei topic in ROS 2 che, come già menzionato,

si basa proprio su quest’implementazione di DDS. Sono infatti presenti gli
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CAPITOLO 2. TECNOLOGIE UTILIZZATE

stessi concetti di topic, topic type, QoS, publisher e subscriber, anche se leg-

germente più articolati. I Publisher, in questo contesto, sono le entità che

creano e configurano i DataWriter, ovvero le entità che pubblicano i mes-

saggi su un determinato topic (ciascun DataWriter può pubblicare su un

solo topic). In modo del tutto analogo i Subscriber creano e configurano i

DataReader, che leggono i messaggi pubblicati su un topic. I Publisher e

Subscriber sono contenuti nei DomainParticipant (concettualmente simili ai

nodi in ROS 2). Tutti i DomainParticipant che scambiano tra loro messaggi

sui medesimi topic appartengono allo stesso DDS Domain. Ogni entità de-

scritta, fatta eccezione per il DDS Domain, ha i propri QoS. Questa struttura

è rappresentata nella Figura 2.3.

Figura 2.3: Organizzazione delle entità in un DDS Domain

Per poter comunicare correttamente su un topic, tutte le entità coinvolte

devono utilizzare la stessa struttura per i dati scambiati. eProsima Fast DDS

mette a disposizione un tool, chiamato Fast DDS-Gen. Questo strumento

genera, a partire da un file IDL (Interface Definition Language), il codice

sorgente necessario a definire il tipo di dato, che può di conseguenza essere

scambiato su un topic.
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Capitolo 3

Integrazione ROS 2 - Unity

Prima di entrare nella descrizione dettagliata dell’utilizzo di Unity come si-

mulatore per applicazioni robotiche è utile comprendere come avviene l’inte-

grazione tra il motore grafico Unity ed il framework ROS 2.

Unity Technologies mette a disposizione strumenti, documentazione, ri-

sorse e tutorial per la simulazione robotica in Unity attraverso una serie di

repository GitHub. La principale è Unity Robotics Hub [1]. Il file READ-

ME.md di questa repository contiene anche i riferimenti a ROS TCP Connec-

tor e ROS TCP Endpoint, due repository contenenti il materiale necessario

all’integrazione tra ROS 2 e Unity.

Il materiale in ognuna di queste repository si occupa di un lato della co-

municazione che si instaura tra il lato Unity (ROS TCP Connector) e il lato

ROS 2 (ROS TCP Endpoint). Lo scambio di informazioni tra i due ambienti

avviene tramite scambio di messaggi serializzati sfruttando i protocolli TC-

P/IP. In ROS TCP Connector viene implementato il lato client e in ROS

TCP Endpoint il lato server.

3.1 ROS TCP Endpoint

Il lato server della comunicazione TCP/IP è implementato nei file contenu-

ti nella repository ROS TCP Endpoint. Il linguaggio di programmazione

utilizzato è Python.
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CAPITOLO 3. INTEGRAZIONE ROS 2 - UNITY

Il server TCP/IP vero e proprio viene implementato nella classe TcpSer-

ver, contenuta nel file server.py. Questo importa una serie di file, anch’essi

contenuti in ROS TCP Endpoint, per gestire publisher, subscriber e servizi

dell’ambiente ROS 2 ed altre funzioni di supporto. Questi file utilizzano la

libreria python rclpy, messa a disposizione da ROS 2.

Alla richiesta, da parte del client, di creare un nuovo publisher su un

determinato topic, il server crea un’istanza della classe RosPublisher, la quale

crea effettivamente un nodo ROS 2. Per ogni publisher viene creato un

nodo ROS 2 dedicato. Quando il client comunica al server un messaggio

da publicare su un topic, il server comunica i dati all’istanza corretta di

RosPublisher, che si occupa di pubblicare effettivamente il messaggio sul

topic. Analogamente, la richiesta di creare un nuovo subscriber da parte

del client viene gestita creando una nuova istanza della classe RosSubscriber,

che crea un nuovo nodo ROS 2 contenente un subscriber sul topic desiderato.

Ogni qualvolta questo subscriber riceve un messaggio sul topic, lo passa al

server che lo serializza e lo trasmette al client.

3.2 ROS TCP Connector

I programmi che si occupano del lato Unity della comunicazione, contenu-

ti nella repository ROS TCP Connector, sono scritti in C#, nativamente

supportato da Unity.

Il componente principale è la classe ROSConnection, implementata nello

script ROSConnection.cs. L’istanza di questa classe assume il ruolo di client

nella comunicazione TCP/IP.

Inoltre, questa classe si occupa di fornire un’interfaccia agli script C#

che si occupano di simulare i sensori e gli attuatori dei robot in Unity. Per

poter comunicare sfruttando ROS 2, questi script devono ottenere l’istanza

della classe ROSConnection, che implementa il design pattern singleton. I

metodi di questa classe, che gli script chiamano una volta ottenutane l’i-

stanza, nascondono la comunicazione TCP/IP tra Unity e ROS 2 e forni-

scono una struttura del tutto simile a quella dei metodi implementati nelle

librerie fornite da ROS 2 per iscriversi come publisher o subscriber ad un
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CAPITOLO 3. INTEGRAZIONE ROS 2 - UNITY

topic e per pubblicare e ricevere messaggi. È infatti ROSConnection che

si occupa di serializzare i messaggi ROS 2 ricevuti dagli script (per creare

publisher, subscriber o publicare su un topic) e di inviarli al server. Analoga-

mente, de-serializza i messaggi ricevuti dal server per passarli poi agli script

interessati.

3.3 Esempio e architettura

Per chiarire il meccanismo e l’architettura ideati da Unity Technologies per

integrare ROS 2 nel game engine si procede analizzando un esempio pratico,

rappresentato graficamente nella Figura 3.1. I blocchi ROS TCP Connector

e ROS TCP Endpoint rappresentano i programmi contenuti nelle repository

descritte in sezione 3.2 e sezione 3.1, rispettivamente.

L’obiettivo è che le immagini JPEG provenienti da un GameObject inter-

no alla simulazione Unity vengano pubblicate su un topic ROS 2.

Internamente alla scena Unity viene eseguito lo script MyCameraPub.cs,

che esegue i metodi Start() e Update(), ereditati dalla classe base di Uni-

ty MonoBehaviour, si veda a riguardo la sezione 2.1. Nel metodo Start(),

lo script MyCameraPub.cs ottiene l’istanza di ROSConnection e ne chiama

il metodo relativo alla creazione di un publisher su un determinato topic,

ovvero RegisterPublisher(). Nel metodo Update() chiama il metodo di RO-

SConnection relativo alla pubblicazione dei messaggi, ovvero Publish(). I

messaggi sono di tipo CompressedImage e contengono l’immagine ottenuta

chiamando il metodo CamCapture() di MyCamera.cs.

Il client serializza i messaggi e li invia al server, che si occupa della creazio-

ne di un nuovo nodo ROS 2 contenente un publisher (nel caso della chiamata

di RegisterPublisher()) e alla pubblicazione dei messaggi sul topic (nel caso

delle chiamate di Publish()). Per una descrizione più accurata del meccani-

smo necessario ad implementare una camera in Unity, si veda il Capitolo 6.
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Figura 3.1: Integrazione ROS 2 - Unity con un esempio
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Capitolo 4

Introduzione alla simulazione in

Unity

In questo capitolo vengono descritti gli elementi fondamentali per creare e

configurare una simulazione robotica in Unity sfruttando la comunicazione

con ROS 2. Per iniziare una nuova simulazione bisogna accedere all’Unity

Hub e creare un nuovo progetto (di tipo 3D Core) o aprirne uno preesistente

(per maggiori dettagli si veda l’Appendice A). Nel primo caso si aprirà

l’Editor con una scena praticamente vuota. Gli elementi fondamentali di

una simulazione sono il robot e l’ambiente in cui si trova. Le sezioni 4.2 e 4.3

si concentrano su questi due aspetti. La sezione 4.1 invece descrive i passi

da seguire per configurare la comunicazione tra Unity e ROS 2.

4.1 Setup della comunicazione ROS 2 - Unity

Come detto nel Capitolo 3, per fare in modo che la simulazione comunichi

con componenti esterni attraverso ROS 2, Unity mette a disposizione due

repository GitHub: ROS TCP Connector (disponibile al link: https://

github.com/Unity-Technologies/ROS-TCP-Connector) e ROS TCP

Endpoint (disponibile al link: https://github.com/Unity-Technologies/

ROS-TCP-Endpoint).
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CAPITOLO 4. INTRODUZIONE ALLA SIMULAZIONE IN UNITY

Per poter usufruire di ROS TCP Connector, nell’Editor bisogna apri-

re Window→Package Manager, da qui bisogna premere sul + in alto a si-

nistra, premere Add package from git URL... ed inserire il seguente url:

https://github.com/Unity-Technologies/ROS-TCP-Connector.git?p

ath=/com.unity.robotics.ros-tcp-connector. A questo punto per

configurare la connessione: Robotics→ROS Settings, indicare come Protocol

ROS2 e come ROS IP Adress l’indirizzo IP della propria macchina, per il

resto si possono mantenere le impostazione di default. A questo punto è

disponibile in Assets→Resources il prefab ROSConectionPrefab. Un prefab

in Unity è un GameObject, completo di eventuali componenti e altri ogget-

ti figli, riutilizzabile a piacimento all’interno del progetto. Modificare un

prefab porta alla modifica di tutte le sue istanze. Il prefab ROSConection-

Prefab (compresi anche i suoi componenti, in particolare lo script ROSCon-

nection.cs) rappresenta il lato client della comunicazione TCP/IP descritta

nel Capitolo 3.

Per quanto riguarda ROS TCP Endpoint, è necessario creare uno work-

space ROS 2 (per maggiori informazioni si vedano i tutorial nella documen-

tazione di ROS 2 [2]). Nella cartella src di tale workspace eseguire il git

clone del branch main-ros2 della repository. Dopodichè si può procedere

eseguendo il comando colcon build dal terminale. Per eseguire il codice

che prende parte alla cominicazione TCP/IP come server bisogna eseguire

dal terminale, dopo i comandi per il source dei file di setup di ROS 2 e dello

workspace appena creato, il comando:

$ ros2 launch ro s t cp endpo in t endpoint . py

A questo punto, avviando la simulazione con il tasto Play dell’Editor, l’am-

biente ROS 2 e la simulazione in Unity possono comunicare.

4.2 Modello del robot e URDF Importer

In Unity i robot sono modellati come GameObject con i propri component ed

eventuali altri oggetti figli. Di seguito viene presentata una veloce descrizione

dei principali component utili per modellare le caratteristiche di un robot:
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• Rigidbody: fa in modo che i movimenti dell’oggetto a cui è assegna-

to siano influenzati dal motore fisico di Unity, per esempio rendendo-

lo soggetto alla forza di gravità. Si possono settare alcuni parametri

attraverso l’Editor, come ad esempio la massa dell’oggetto associato.

• Collider: definiscono la forma dell’oggetto per quanto riguarda le colli-

sioni con altri oggetti (i quali a loro volta devono avere un componente

Collider). Esistono diversi tipi di Collider, ciò che li differenzia è la loro

forma, ad esempio i BoxCollider hanno la forma di un parallelepipedo

retto, mentre gli SphereCollider di una sfera. I Collider non influenzano

in alcun modo la forma visibile dell’oggetto nella simulazione.

• Mesh Collider: sono un particolare tipo di Collider la cui forma è de-

finita in un file che descrive un Mesh. Un Mesh è un reticolo che

definisce un oggetto nello spazio e permette quindi di definire forme

complesse. Il problema è che i Mesh Collider non possono interagire

tra loro (non possono collidere). È possibile indicare un Mesh Collider

come “convex” (attraverso l’Editor) in modo che si comporti come un

normale Collider, questa opzione però semplifica la forma del Collider,

rendendola meno precisa.

• Mesh Filter e Mesh Renderer: Questi due componenti devono essere

usati in coppia sullo stesso oggetto. Il primo è semplicemente un riferi-

mento ad un Mesh, il secondo ha il compito di “renderizzarlo”, ovvero

definire la forma visibile dell’oggetto nella simulazione. Il Mesh Rende-

rer ha diversi parametri utili a modificare l’aspetto dell’oggetto, si può

specificare ad esempio l’aspetto della superficie dell’oggetto indicando

nell’Editor un Material (descritto in un apposito file che deve essere tra

gli Asset del progetto). Ad esempio, un Material può simulare l’aspetto

di un materiale metallico.

• Articulation Body: permette di creare articolazioni tra gli oggetti che

compongono una gerarchia. Sono stati realizzati appositamente da

Unity per modellare articolazioni fisiche realistiche per applicazioni

industriali.
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• Script: permettono di modellare il comportamento del robot attraver-

so programmi scritti in C# (o UnityScript). Nel codice degli Scipt si

possono leggere e modificare le proprietà degli altri component della

simulazione. I valori delle variabili dichiarate come pubbliche all’in-

terno del codice di uno Script possono essere modificati manualmente

attraverso l’Editor, anche quando la simulazione è in esecuzione.

Figura 4.1: Alcuni component di un GameObject nell’Inspector dell’Editor
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Per aggiungere un componente ad un GameObject bisogna selezionar-

lo nella Hierarchy nell’Editor, allora nell’Inspector selezionare Add Compo-

nent e scegliere il component che si vuole aggiungere all’oggetto. I compo-

nent attivi su un oggetto sono visibili attraverso l’Inspector, cos̀ı come i loro

parametri.

È possibile creare un robot in Unity “manualmente”, ovvero creando una

gerarchia di GameObject, ciascuno con i propri component, attraverso l’Edi-

tor. Tuttavia Unity mette a disposizione un tool, ovvero URDF Importer,

che permette di importare in una simulazione il modello di un robot generato

a partire da un file URDF. Lo Unified Robot Description Format (URDF) è

una specifica XML utilizzata per la descrizzione di robot in una struttura ad

albero. URDF permette di specificare:

• la descrizione cinematica e dinamica del robot;

• la rappresentazione visuale del robot;

• il modello delle collisioni del robot.

Come detto, URDF Importer, il cui codice è disponibile al link https:

//github.com/Unity-Technologies/URDF-Importer, permette di im-

portare un robot nella simulazione, andando a definire automaticamente l’a-

spetto visuale del robot (attraverso dei Mesh) ed i suoi attributi dinamici e ci-

nematici. I robot importati con questo tool sono costituiti, prevalentemente,

da oggetti contenenti componenti di tipo Articulation Body.

Per poter utilizzare URDF Importer nel proprio progetto Unity è ne-

cessario importarlo attraverso il Package Manager (come descritto per ROS

TCP Connector). L’url da inserire è: https://github.com/Unity-Techn

ologies/URDF-Importer.git?path=/com.unity.robotics.urdf-impor

ter#v0.5.2. Per poter importare un robot a partire da un file URDF, è

necessario che questo si trovi tra gli Asset del progetto. Per importare un file

tra gli Asset si può semplicemente copiare tramite il file system del sistema

operativo il file (o la cartella) desiderato nella cartella Assets. Una volta

individuato, all’interno dell’Editor, il file URDF desiderato, lo si deve sele-

zionare, premere il tasto destro del mouse e selezionare Import Robot from
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Selected URD file. A questo punto si apre una finestra in cui si può selezio-

nare l’orientamento dei file Mesh necessari e scegliere l’algoritmo che verrà

utilizzato per calcolare i Mesh Collider da applicare al robot. Per quest’ul-

tima opzione si può scegliere l’algoritmo di default usato da Unity oppure

VAHD, che permette di ottenere Collider più fedeli per i Mesh Collider con

l’opzione “convex” abilitata. Una volta scelte le opzioni si può importare il

robot premendo import URDF. Per poter funzionare, URDF Importer ha

bisogno dei file Mesh indicati nel file URDF stesso, che devono trovarsi tra

gli Asset in una cartella specifica come definito nel file URDF. Solitamente

questi file sono forniti insieme al file URDF che descrive il robot.

Spesso, una volta importato un robot attraverso URDF Importer, è ne-

cessario intervenire manualmente attraverso l’Editor per sistemare i diversi

Collider e Articulation Body generati automaticamente, che potrebbero in-

terferire tra di loro. Inoltre l’oggetto che rappresenta il robot sarà trattato

come un prefab, non sarà quindi possibile modificarlo in libertà senza in-

fluenzare le altre istanze di tale prefab. Per ovviare a questo problema si puo

procedere come segue: nella Hierarchy selezionare la radice dell’oggetto (che

sarà colorata in blu per evidenziare che è un’istanza di un prefab), premere

il tasto destro del mouse, selezionare Prefab e infine Unpack Completely. A

questo punto sarà possibile modificare il robot in totale libertà aggiungendo

nuove parti o componenti e rimuovendone altre.

4.3 Ambiente

Unity permette di modificare l’ambiente con cui il robot interagisce con molta

libertà. A tale scopo si possono aggiungere alla simulazione dei GameObject

che rappresentano oggetti di qualsivoglia natura, come muri, piani, sedie o

alberi. Questi oggetti possono essere molto semplici e stilizzati oppure mol-

to realistici. nel primo caso basta aggiungere alla simulazione oggetti base

forniti da Unity, come cilindri e cubi, a cui si possono assegnare gli stes-

si component descritti per il robot per modellarne le caratteristiche fisiche.

Questi oggetti possono essere aggregati in oggetti più complessi.
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Se invece si vogliono utilizzare oggetti più realistici, è possibile realizzare

dei modelli tridimensionali con software come Blender o Autodesk Maya, che

possono essere importati nella simulazione. Un’alternativa molto più sempli-

ce è importare modelli già pronti per essere utilizzati, disponibili sul sito di

Unity Asset Store, al link https://assetstore.unity.com/. Questo sito

mette a disposizione una moltitudine di pacchetti scaricabili ed utilizzabili

nei progetti Unity, che forniscono diversi tipi di risorse, come tool, scripts e

oggetti. Per questo lavoro è stato, per esempio, utilizzato un pacchetto con-

tenente oggetti (sotto forma di prefab) che modellano forniture tipiche di un

ufficio. Anche se la maggior parte dei pacchetti disponibili sono a pagamento,

esiste un nutrito gruppo di elementi gratuiti.

Per scaricare ed utilizzare gli elementi forniti da un pacchetto di Unity

Asset Store bisogna entrare nel sito ed accedere con lo stesso account Unity

con cui si è acceduti nell’Unity Hub. Una volta individuato il pacchetto

desiderato premere Add to My Assets (se necessario prima bisogna procedere

col pagamento). A questo punto entrare nell’Editor di Unity ed aprire il

Package Manager, selezionare quindi in alto a sinistra Package: My Assets.

A questo punto si può visualizzare la lista dei pacchetti associati al proprio

account, selezionare quello interessato, premere Download e poi Import. Ora

in Assets sarà presente una cartella contenente tutti i file associati a tale

pacchetto.

Se il materiale scaricato non è particolarmente recente, gli eventuali Ma-

terial contenuti in esso potrebbero apparire di colore viola. in questo caso è

necessario aggiornarli: selezionare i Material del package tra gli Asset, poi se-

lezionare Edit→Render Pipeline→Universal Render Pipeline→Upgrade Se-

lected Materials to UniversalRP Materials e infine confermare.
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Capitolo 5

Simulazione del robot mobile

TurtleBot3

Se si vuole utilizzare Unity come ambiente di simulazione di robot mobili su

due ruote, Unity Technologies mette a disposizione un progetto, uno work-

space ROS 2 e dei tutorial che forniscono un buon punto di partenza. Quanto

elencato è contenuto nella repository GitHub https://github.com/Unity

-Technologies/Robotics-Nav2-SLAM-Example. Il materiale permette

di simulare un robot mobile, il TurtleBot3 Waffle Pi, e fare localizzazione

e mappatura simultanea (Simultaneous Localization And Mapping, SLAM),

ovvero costruire e tenere aggiornata una mappa di un ambiente sconosciuto,

tenendo contemporaneamente traccia della posizione del robot al suo interno.

Figura 5.1: TurtlebBot3 Waffle Pi reale e nella simulazione

Per sviluppare il progetto Unity descritto nell’Appendice B (ovvero uni-

ty project) è stato modificato appunto questo progetto fornito da Unity Tech-
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nologies. Si ritiene utile fare una overview di questi materiali e una valutazio-

ne complessiva dell’ambiente messo a disposizione da Unity Technologies per

la simulazione di robot mobili. Nei capitoli successivi si tratterà come espan-

dere questo ambiente aggiungendo nuovi sensori (Capitolo 6) e l’odometria

(Capitolo 8).

Una volta clonata la repository in locale si può aprire il progetto Unity,

chiamato Nav2SLAMExampleProject, da Unity Hub. Il package ROS TCP

Connector è già importato all’interno del progetto. Gli elementi fondamenta-

li sono contenuti in Assets, nelle cartelle Prefabs, Resources, Scenes e Scripts.

Nella cartella Prefabs è contenuto il prefab TurtleBot3ManualConfig, ovve-

ro una particolare configurazione creata da Unity Technologies modificando

l’oggetto generato dal tool URDF Importer a partire dal file URDF del ro-

bot. Questa modifica è risultata necessaria anche a causa di problemi con

i Collider, che si sovrapponevano tra loro. Nella cartella Resources si trova

il prefab dell’oggetto ROSConnectionPrefab, descritto nella sezione 4.1. In

Scenes, la scena di maggiore interesse è SimpleWarehouseScene, che simula

l’interno di un magazzino. Infine, nella cartella Scripts è contenuta la logica,

in C#, necessaria a simulare i sensori e gli attuatori del robot:

• AGVController.cs: richiede di indicare, attraverso l’Inspector dell’Edi-

tor, due GameObject, ovvero le due ruote del robot, ed altre caratteri-

stiche del robot, come il raggio delle ruote e la distanza tra esse. Crea

un nodo subscriber sul topic /cmd vel e calcola e applica la velocità di

rotazione delle due ruote per far procedere il robot (sfruttando gli Ar-

ticulation Body) in funzione dei messaggi di velocità lineare e angolare

ricevuti sul topic.

• LaserScanSensor.cs: simula un sensore laser LIDAR. Ottiene le in-

formazioni dagli oggetti circostanti solo se questi hanno un compo-

nent di tipo Collider. Queste informazioni vengono pubblicate sul

topic /scan. È possibile specificare diversi parametri, sempre utiliz-

zando l’Inspector, relativi alle scansioni del sensore, come il numero di

scansioni al secondo.
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• Clock.cs e ROSClockPublisher.cs: necessari a mantenere sincronizzati

temporalmente ROS 2 e la simulazione in Unity.

• ROSTransformTreePublisher.cs: insieme a TimeStamp.cs, Transfor-

mExtensions.cs, e TransformTreeNode.cs permette di creare l’albero

delle Transform del robot e di pubblicarlo sul topic /tf.

• FreeCam.cs: non è necessario ai fini della simulazione robotica, per-

mette semplicemente di muoversi all’interno della simulazione con una

camera.

La comunicazione tramite topic tra questi script e due tool esterni, Nav2

e slam toolbox, permette di implementare le funzioni di navigazione e map-

patura. I due tool possono essere lanciati dai launch file contenuti nel pac-

kage unity slam example dello workspace ROS 2 colcon ws (contenuto nella

cartella ros2 docker della repository). Questo workspace contiene anche il

package ROS TCP Endpoint. Questo materiale ha lo scopo di sostituire il

simulatore di robotica 3D open source Gazebo nel tutorial al link https:

//navigation.ros.org/tutorials/docs/navigation2 with slam.html.

Questi aspetti, che possono essere esplorati seguendo il tutorial messo a

disposizione nella repository, non sono di interesse per questo lavoro, che si

limita all’interazione diretta con gli script presenti nel progetto Unity.

Unity Technologies mette anche a disposizione un package (Robotics Vi-

sualization, già importato in questo progetto) per la visualizzazione dei mes-

saggi all’interno della scena. La visualizzazione può essere sia grafica, simile

quindi ad rviz2, che testuale, attraverso delle finestre. Questo package for-

nisce un prefab contenente gli script necessari all’implementazione di queste

funzioni, che deve essere quindi inserito come oggetto nella scena. In Fi-

gura 5.2 si possono vedere due finestre che mostrano i messaggi pubblicati

sui topic /tf e /cmd vel e la visualizzazione grafica delle informazioni pub-

blicate sul topic /map. Questo package sembra mostrare diversi problemi

con alcuni topic. Ad esempio la visualizzazione grafica del topic /scan, che

dovrebbe essere un point cloud, non funziona. I tutorial nella repository,

accennati precedentemente, coprono anche l’utilizzo di questo package e in-

dicano anche come personalizzare la visualizzazione. Per questo lavoro non è
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Figura 5.2: Esempio di utilizzo del package Robotics Visualization

stato utilizzato Robotics Visualization ma rviz2 (anche a causa del problema

riscontrato con /scan).

Risultano di interesse per questo lavoro solamente il progetto Unity e in

particolar modo gli script sopra elencati ed il modello del robot TurtleBot3.

L’obiettivo infatti è poter pubblicare direttamente comandi riguardanti la

velocità lineare ed angolare del robot per farlo muovere e ricevere i dati del

sensore LIDAR e, in fasi successive del lavoro, di Tranform.

Sono stati scritti a tal proposito due programmi C++ che, attraverso la

libreria ufficiale rclcpp, implementano altrettanti nodi ROS 2:

• cmd vel publisher.cpp: registra un publisher sul topic /cmd vel e invia

un messaggio di tipo Twist ogni 0.5 secondi. Il tipo Twist fa parte

del package geometry msgs, messo a disposizione da ROS 2. Contiene

due vettori (linear e angular), ciascuno composto da tre float64 (x, y e

z), che specificano la velocità lineare e angolare del robot. I messaggi

pubblicati da questo publisher vengono ricevuti dal nodo subscriber

implementato in AGVController.cs. Essendo il TurtleBot3 un robot

con due ruote fisse, questo script utilizza solo i valori di linear x e

angular z per calcolare la velocità di rotazione delle ruote. Questo

publisher publica messaggi con linear x = 0.1 e angular z = 0.0. Quindi

si comanda al robot di procedere dritto ad una velocità di 0.1m/s.
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• scan subscriber.cpp: registra un subscriber sul topic /scan e attende

messaggi di tipo LaserScan. Questo tipo di messaggio fa parte del pac-

kage sensor msgs, messo anch’esso a disposizione da ROS 2. Il tipo

LaserScan contiene un array (ranges[]) di float32. L’array rappresenta

l’insieme delle misurazioni fatte in una scansione. Inoltre, LaserScan

contiene altre informazioni relative alle scansioni, come la massima e

minima distanza misurabile (range max e range min) e l’angolo tra

una misurazione e l’altra (angle increment). Per ogni messaggio rice-

vuto lo script stampa su console il primo e l’ultimo valore di ranges[].

Sul questo topic pubblica messaggi il nodo publisher implementato in

LaserScanSensor.cs.

Questi due programmi si possono trovare nella cartella ros unity sim, nello

workspace ROS 2 ros ws, package unity pub sub. A tal proposito si faccia

riferimento all’Appendice B.

Per visualizzare i messaggi di tipo LaserScan è possibile utilizzare il tool

rviz2, che li rappresenta con un point cloud. Per avviare rviz2 bisogna, dopo

aver fatto il source del file di setup di ROS 2, eseguire il seguente comando

nel terminale:

$ ros2 run rv i z 2 r v i z 2

Una volta aperto rviz2 sarà sufficiente aggiungere il topic /scan per visualiz-

zare graficamente i messaggi publicati da LaserScanSensor.cs.

Utilizzando il programma cmd vel publisher.cpp il robot dovrebbe prose-

guire dritto senza curvare, dal momento che non si applica nessuna velocità

angolare. Il comportamento osservato nella simulazione, però, è una curva-

tura della traiettoria del robot il cui angolo diminuisce all’aumentare della

velocità lineare. Questo problema è trattato nel Capitolo 7.
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Capitolo 6

Aggiunta di sensori al robot

I sensori sono una parte fondamentale di ogni robot ed è quindi importante

poterli simulare. In Unity i sensori vengono modellati attraverso gli Script

C#, assegnabili agli oggetti. Ad esempio, nella simulazione discussa nel

Capitolo 5 il robot è dotato di un sensore LIDAR. Questo è realizzato come

un albero di GameObject, la cui radice è un oggetto (chiamato base scan)

che contiene lo script LaserScanSensor.cs, il quale modella il comportamento

del sensore. Quindi per aggiungere nuovi sensori è necessario disporre degli

Script che ne implementino il comportamento.

In rete non c’è molta disponibilità di Script per simulare sensori in Unity.

Alcuni sensori possono essere trovati alle seguenti repository GitHub: https:

//github.com/Field-Robotics-Japan/UnitySensors e https://gith

ub.com/Field-Robotics-Japan/UnitySensorsROS, che congiuntamente

permettono di simulare diversi sensori e pubblicare i dati ottenuti su topic di

ROS 2. Una prova di questo materiale ha però evidenziato diversi problemi

(per esempio gli Script non vengono compilati correttamente per un errore

del tipo di una variabile) che ne precludono l’utilizzo.

Per aggiungere nuovi sensori ad una simulazione Unity potrebbe quindi

risultare necessario scrivere il codice da zero. Per questo lavoro si è deciso

di scrivere degli Script, prendendo come spunto quelli già forniti da Unity e

quelli delle repository sopraccitate, che modellino una camera da applicare

al TurtleBot3. L’obbiettivo di questo sensore è di pubblicare messaggi di
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tipo CompressedImageMsg, contenenti le immagini che cattura, sul topic

/image/compressed.

Gli Script non sono però sufficienti a realizzare questo sensore. Per prima

cosa è necessario creare un oggetto vuoto (chiamato CameraROS), aggiun-

gerlo nella gerarchia del robot come figlio dell’oggetto base link e spostarlo in

modo che si “appoggi” su una superficie del robot. Dopodiché va aggiunto a

CameraROS il component Camera che permette di raccogliere immagini dalla

simulazione. Per rendere il sensore più realistico si può impostare il parame-

tro Clipping Planes Near del componente appena aggiunto al valore minimo

0.01, in modo che la camera non “tagli” gli oggetti vicini ad essa. Infine si

deve creare tra gli Assets un Render Texture (nella finestra Project dell’Edi-

tor, premere tasto destro in Assets→Create→Render Texture) e rinominarlo

renderCamera. Una volta selezionato renderCamera nell’Inspector si posso-

no modificare i suoi parametri. In particolare bisogna impostare il valore di

Dimension a 2D e scegliere la risoluzione dell’immagine che verrà trasmessa

modificando Size. Per applicare renderCamera a CameraROS bisogna sele-

zionare CameraROS nella gerarchia degli oggetti e trascinare renderCamera

sull’attributo Output Texture del componente Camera nell’Inspector.

Gli Script scritti per questo sensore sono due: MyCamera.cs e MyCa-

meraPub.cs, entrambi disponibili in Scripts/myRGBCamera tra gli Asse-

ts del progetto unity project (si veda l’Appendice B). Ambedue gli Script

contengono una classe che eredita dalla classe MonoBehaviour.

MyCamera, la classe implementata in MyCamera.cs, contiene il solo me-

todo pubblico CamCapture(), questo accede al component Camera (e di con-

seguenza al Render Texture associato), ottiene da esso un’immagine e salva

in codifica JPEG un array di byte in una variabile pubblica (chiamata data).

La classe implementata in MyCameraPub.cs contiene i metodi Start() e

Update(), ereditati da MonoBehaviour. In Start() si ottiene un’istanza della

classe MyCamera e si configura la comunicazione ROS 2 ottenendo l’istanza

di ROSConnection e registrando un publisher sul topic /image/subscriber.

Nel metodo Update() si chiama il metodo CamCapture() di MyCamera, si

configura il messaggio (che contiene anche i dati della variabile pubblica data

di MyCamera) e infine lo si pubblica sul topic. Le immagini non vengono
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pubblicate ogni volta che viene eseguito Update() (ovvero ad ogni frame della

simulazione), ma ad una frequenza minore. Questa può essere impostata

modificando il parametro Scan Rate dello Script attraverso l’Inspector.

Per completare la configurazione del sensore è sufficiente assegnare all’og-

getto CameraROS, descritto precedentemente, lo Script MyCameraPub.cs;

in automatico verrà aggiunto anche MyCamera.cs.

Analizzando il codice di MyCameraPub.cs si può notare la semplicità con

cui è possibile creare un publisher ROS 2 in una simulazione Unity utilizzando

la classe ROSConnection. È sufficiente infatti creare una variabile di tipo

ROSConnection:

private ROSConnection _ros;

successivamente creare un publisher nel metodo Start():

this._ros = ROSConnection.GetOrCreateInstance();

this._ros.RegisterPublisher<CompressedImageMsg>(

this._topicName);

infine, ogni qualvolta si vuole pubblicare un messaggio, chiamare il metodo

Publish():

this._ros.Publish(this._topicName, this._message);

Per testare questo sensore è stato scritto image subscriber.cpp, un pro-

gramma che implementa un nodo ROS 2 con un subscriber sul topic /ima-

ge/compressed. Ogni qualvolta il subscriber riceve un messaggio su questo

topic, il programma, sfruttando la libreria open source OpenCV, salva un

file JPEG in locale contenente l’immagine racchiusa nel messaggio. Le im-

magini vengono salvate nella cartella in cui si lancia il comando per eseguire

il programma. La Figura 6.1 mostra un esempio di immagine catturata nella

simulazione, pubblicata tramite ROS 2 e salvata con OpenCV.

Le immagini pubblicate da MyCameraPub.cs possono essere visualizzate

anche con il plugin rqt image view, mentre rviz2 riconosce il topic ma non

riceve le immagini.
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Figura 6.1: Immagine pubblicata da MyImagePub.cs e salvata da ima-
ge subscriber.cpp
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Capitolo 7

Movimento di TurtleBot3

Come già accennato, il TurtleBot3 della simulazione discussa nel Capitolo 5

presenta un’anomalia nel movimento. Infatti, quando riceve un comando di

procedere dritto sul topic /cmd vel, il robot si muove seguendo una traiet-

toria curva. La curvatura è tanto maggiore quanto più è alta la velocità

lineare (linear x) specificata nel messaggio. Questo problema non consente

di modellare fedelmente il comportamento del robot.

Lo Script che riceve i messaggi pubblicati sul topic /cmd vel e comanda

il movimento del robot è AGVController.cs. Analizzandone il codice si può

notare che questo programma, quando la variabile ControlMode è impostata

al valore ROS, utilizza i componenti linear x e angular z dei messaggi pub-

blicati sul topic per calcolare la forza da applicare alle ruote del robot. Per

calcolare questa forza utilizza come parametri il raggio delle ruote e la distan-

za tra di esse. La forza viene applicata al parametro xDrive dei component

Articulation Body associati alle ruote, che iniziano quindi a ruotare. Il mo-

vimento delle ruote influisce sugli altri oggetti del robot con un Articulation

Body attivo. Tutto questo permette al robot di muoversi. Si fa notare che un

messaggio pubblicato sul topic aziona le ruote per un massimo di 0.5 secondi,

dopodiché il robot viene arrestato in attesa di un nuovo messaggio. Questo

tempo può essere personalizzato modificando il parametro ROS Timeout di

AGVController.cs.

Per verificare il funzionamento dello Script, si può avviare la simulazione
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e pubblicare su /cmd vel ogni 0.5 secondi un messaggio con linear x pari,

per esempio, a 0.5 e tutti gli altri valori a 0. Il robot inizierà quindi a muo-

versi, ma non seguendo una traiettoria retta. Selezionando nella Hierarchy

dell’Editor l’oggetto della ruota destra che contiene l’Articulation Body, si

può notare nell’Inspector il valore di xDrive applicato alla ruota. Seguendo

la stessa procedura per la ruota sinistra si verifica che i valori applicati al

parametro xDrive delle ruote sono identici. Ci si aspetterebbe quindi che il

robot prosegua in linea retta, ma cos̀ı non è.

Si pensa che questa anomalia sia dovuta al modello del robot, in parti-

colar modo all’interazione tra i component di tipo Collider ed Articulation

body. Per ovviare a questo problema si è quindi provato a modificare la

struttura e la forma del robot, prestando particolare attenzione ai Collider.

Le varie configurazioni ottenute mostravano comportamenti diversi: in alcuni

casi la curvatura era particolarmente importante, in altri era meno evidente.

In nessun caso però il problema è stato completamente risolto. Inoltre, si è

provato sia a creare nuovi robot molto semplici direttamente attraverso l’E-

ditor che ad importare e modificare altri modelli di robot su due ruote con

URDF Importer, ma il risultato non è cambiato.

È stato quindi cambiato approccio. Si è deciso di muovere il robot mo-

dificandone direttamente la posizione assoluta rispetto al centro della scena

simulata. Per prima cosa è stato modificato il robot (partendo dalla con-

figurazione iniziale fornita da Unity) rimuovendo tutti i component Articu-

lation Body e gli script generati da URDF Importer che dipendevano da

essi. Dopodiché è stato rimosso caster center manual config dalla gerarchia

degli oggetti e si è modificato il Box Collider principale del robot (presente

nella sottogerarchia di base link). È stato anche agggiunto a base footprint

un RigidBody per modellare alcuni aspetti del robot che prima dipendevano

dagli Articulation Body, come ad esempio la massa. Infine è stato sostituito

AGVController.cs con il nuovo Script GTController.cs.

Questo programma ha una struttura simile ad AGVController.cs per

quanto riguarda la ricezione dei comandi pubblicati su /cmd vel, ma differi-

sce nel modo in cui fa muovere il robot. GTController.cs contiene un metodo,

denominato FixedUpdate() ed ereditato dalla classe MonoBehaviour, che vie-
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ne eseguito ogni lasso di tempo fissato. Questo tempo può essere visualizzato

e modificato attraverso l’Editor: Edit→Project Settings→Time→Fixed Ti-

mestep. In questo metodo viene ottenuta la posizione assoluta attuale del

robot, che viene poi utilizzata insieme ai comandi di velocità per calcolare la

posizione finale da applicare al robot. Per questi calcoli è necessario disporre

della distanza tra le due ruote (che viene specificata attraverso il parametro

track Width, modificabile attraverso l’Editor) e del Fixed Timestep descritto

prima, a cui si può accedere all’interno del programma come segue:

float step = Time.deltaTime;

Per fare in modo che GTController.cs funzioni correttamente è necessario

assegnare attraverso l’Editor l’oggetto base footprint al parametro Gt dello

Script. Questo permette al programma di accedere alla posizione del robot

e di modificarla.

7.1 Implementazione di zone scivolose

Nello Script GTController.cs è stata anche implementata la logica per simu-

lare la presenza di zone scivolose nel piano su cui si muove il robot. L’idea

è che quando una ruota del robot si trova su una di queste zone, essa per-

da trazione ed inizi a scivolare. Questo influenza ovviamente sia la velocità

angolare che lineare del robot.

Per modellare le zone scivolose è stato scelto di utilizzare dei GameOb-

ject di tipo Plane, che possono essere sovrapposti al piano principale nelle

zone desiderate. In Figura 8.1 si possono notare due piani (di colore blu) che

modellano altrettante zone scivolose. A questi piani va applicato un nuovo

Script, ovvero PlaneFriction.cs. Questo programma implementa una classe

che contiene la sola variabile pubblica friction. Questa variabile è modifica-

bile attraverso l’Editor e può assumere valori compresi tra 0 e 1. Rappre-

senta l’attrito del piano: più basso è il suo valore e più le ruote scivolano,

rallentando di conseguenza il movimento del robot.

GTController.cs è stato modificato per poter accedere alla posizione delle

ruote e alle caratteristiche di un numero arbitrario di piani (a cui deve es-
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sere applicato PlaneFriction.cs). Questi oggetti vanno assegnati, attraverso

l’Inspector, al component relativo a GTController.cs, come in Figura 7.1.

Figura 7.1: Esempio di GTController.cs nell’Inspector

GTController.cs presenta tre problematiche:

• le zone scivolose possono avere solo la forma di piani rettangolari non

ruotati;

• se le due ruote si trovano contemporaneamente su due piani scivolosi

con valori di attrito diversi, il robot si comporta come se entrambe le

ruote fossero su una zona con attrito pari a quello della zona su cui si

trova la ruota sinistra;

• quando una sola ruota è su un’area scivolosa l’angolo di curvatura del

robot cambia continuamente.

Gli Script GTController.cs e PlaneFriction.cs si trovano in Scripts/my-

Controllers tra gli Assets del progetto unity project (si veda l’Appendice B).

36



Capitolo 8

Aggiunta dell’odometria

L’odometria permette di stimare la posizione attuale del robot rispetto a

quella iniziale attraverso i dati sul movimento (rotazione) delle ruote, ottenuti

attraverso dei sensori, ad esempio degli encoder ottici. La posizione reale del

robot e quella ottenuta con l’odometria possono differire a causa di zone

scivolose sulle quali le ruote del robot continuano a girare ma il robot stesso

avanza più lentamente (come conseguenza dello slittamento). L’odometria si

discosta dalla posizione effettiva del robot anche nel caso in cui il robot reale

sia bloccato da un ostacolo ma le ruote continuano a girare.

L’odometria è un aspetto fondamentale nell’ambito dei robot mobili e

quindi risulta di interesse poterla aggiungere all’interno dell’ambiente di si-

mulazione di Unity. L’implementazione dell’odometria in questo progetto

prevede di simulare e visualizzare all’interno della scena la posizione del ro-

bot che verrebbe calcolata a partire dagli encoder in una situazione reale.

All’interno della scena saranno presenti due robot diversi, uno che simula il

robot reale, l’altro che simula la posizione relativa all’odometria. Il primo ro-

bot (chiamato ground truth) collide con gli oggetti e slitta su zone scivolose,

il secondo (chiamato odom), invece, non collide con nessun oggetto e proce-

de sempre come se si trovasse su un terreno non scivoloso. Entrambi devono

partire nella stessa posizione e non devono collidere tra di loro. In Figura 8.1

il robot semitrasparente simula l’odometria ed è più avanti rispetto al robot

reale perché quest’ultimo si trova su una zona scivolosa (area blu).
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Figura 8.1: Simulazione dell’odometria in Unity

In questo capitolo si tratterà inoltre come pubblicare le informazioni ri-

guardanti la posizione dei due robot (quello reale e l’odometria) rispetto alla

posizione iniziale tramite topic ROS 2. Per far ciò si sfrutterà il topic /tf.

8.1 Implementazione dell’odometria

Per simulare l’odometria si deve ottenere all’interno della scena Unity una

gerarchia come quella mostrata in Figura 8.2. Per ottenere tale gerarchia è

sufficiente creare un nuovo GameObject (turtlebot3) e aggiungere come suoi

figli gli oggetti rappresentanti i due robot, ovvero groud truth e odom. Il pri-

mo è stato ottenuto rinominando l’oggetto turtlebot3 manual config fornito

da Unity e modificato come indicato nel Capitolo 6 e nel Capitolo 7. Invece,

per ottenere odom è necessario:
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• creare una copia di gorund truth all’interno della scena e rinominarla

odom;

• rinominare i figli base footprint, base link, base scan, imu link,

wheel right link e wheel left link aggiungendo il prefisso virtual da-

vanti al nome. Questa operazione è necessaria per pubblicare corretta-

mente le informazioni su /tf;

• eliminare gli elementi superflui, ovvero l’oggetto CameraROS e i com-

ponent ROSClockPublisher in ROSPublisher e LaserScanSensor in vir-

tual base scan.

Figura 8.2: Gerarchia dell’oggetto turtlebot3

Per far s̀ı che il robot che simula l’odometria non collida con gli oggetti

presenti nella scena e con il robot ground truth è possibile sfruttare i layer

di Unity:

• per creare un nuovo layer nel progetto navigare in Edit→Project Set-

tings →Tags and Layers, a questo punto è possibile dare un nome, ad

esempio “virtuale”, ad uno dei layer disponibili;
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• per far s̀ı che gli oggetti del nuovo layer non collidano con gli altri,

navigare in Edit→Project Settings→Physics→Layer Collision Matrix,

a questo punto si devono togliere le spunte tra “virtuale” e tutti gli

altri layer eccetto “virtuale” stesso, come mostrato in Figura 8.3;

Figura 8.3: Matrice dei layer in Unity

• per modificare il layer dell’albero di oggetti odom bisogna selezionare

l’oggetto odom stesso e, nell’Inspector, in alto a destra, cambiare il

layer in “virtuale”. Alla richiesta di applicare la modifica a tutti i figli

rispondere affermativamente;

• per far s̀ı che anche il robot odom abbia un piano su cui appoggiar-

si bisogna aggiungere alla scena un GameObject di tipo Plane, a cui

applicare il layer “virtuale”. Questo piano deve essere sovrapposto a

quello “reale”. Per evitare che il nuovo piano sia visibile è sufficiente

togliere il Material al component Mesh Renderer;

• infine, per evitare che l’oggetto CameraROS di ground truth veda il

robot odom, bisogna selezionare CameraROS e, nell’Inspector, desele-

zionare il layer “virtuale” in Rendering→Culling Mask.

Per differenziare i due robot è possibile cambiare colore ad uno dei due,

oppure, dal momento che il robot odom non simula un robot reale, lo si può

rendere semitrasparente:
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• creare un nuovo Material: Assets→Materials→tasto destro→Create

→Material;

• selezionare questo Material, nell’Inspector cambiare shader come se-

gue: Shaders→Shader Graphs→ArnoldStandardSurfaceTrasparent, a

questo punto si possono cambiare colore (Base Color) e livello di tra-

sparenza (Opacity);

• a questo punto, navigare nellaHierarchy : odom→virtual base footprint

→virtual base link→Visuals→unnamed→waffle base, selezionare uno

alla volta i 5 oggetti che ci sono all’interno e, dall’Inspector, cambiare

il Material del component Mesh Renderer con quello appena creato.

Applicare la stessa procedura per le due ruote e per virtual base scan

(scendendo la gerarchia fin quando si trova un oggetto con Mesh Ren-

derer come component).

Nel progetto unity project contenuto nella cartella ros unity sim, nelle scene

SlipScene e Labs questi passaggi sono già stati eseguiti.

A questo punto l’unico elemento che manca è la logica necessaria a muo-

vere il robot odom. Per implementarla è sufficiente scrivere un nuovo script,

chiamato OdomController.cs, che sostituisca GTController.cs (si veda il Ca-

pitolo 7) come component in odom. Questo nuovo script può essere ottenu-

to da GTController.cs eliminando tutto ciò che riguarda le zone scivolose.

Una volta assegnato OdomController.cs ad odom, è necessario specificare

nell’Inspector l’oggetto comandato (ovvero virtual base footprint), la distan-

za tra le ruote e ROS Timeout. Lo Script si trova in Scripts/myControllers

tra gli Assets del progetto unity project (si veda l’Appendice B)

8.2 Pubblicazione su topic dell’odometria

Per pubblicare le informazioni riguardanti la posizione di ground truth e di

odom rispetto al comune punto di partenza, si sfrutta il topic /tf. Su questo

topic pubblica messaggi lo script ROSTransformTreePublisher.cs (si veda il

Capitolo 5). Le transform pubblicate su /tf dallo script ROSTransformTree-
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Publisher.cs sono organizzate in un albero e per ogni coppia padre-figlio si

hanno a disposizione tre valori per le traslazioni (x, y e z) e quattro per le

rotazioni (x, y, z e w). Questi valori indicano la posizione nello spazio (e la

rotazione) del figlio rispetto al padre. L’esecuzione di ROSTransformTree-

Publisher.cs crea un albero di tf come segue:

map

odom

--albero del root game object--

map e odom sono la stessa cosa, ovvero il riferimento (0 0 0), il centro della

scena. A seguito delle operazioni svolte nella sezione precedente sono due gli

Script ROSTransformTreePublisher.cs in esecuzione: uno per odom e uno per

ground truth. In entrambi i casi lo Script è un component dell’oggetto RO-

SPublishers. Per far s̀ı che si pubblichi un albero come quello in Figura 8.4,

è necessario selezionare l’oggetto ROSPublishers interno alla gerarchia di

ground truth e modificare, nell’Inspector, il component ROSTransformTree-

Publisher.cs, eliminando odom dai Global Frame Ids e mettendo come Root

Game Object l’oggetto ground truth stesso. Analogamente bisogna modifi-

care l’oggetto ROSPublishers interno alla gerarchia di odom, con la differenza

che in questo caso il Root Game Object deve essere l’oggetto odom. Inol-

tre, è necessario aprire lo script ROSTransformTreePublisher.cs e, nel campo

m GlobalFrameIds, eliminare dalla lista la stringa ”odom”.

A questo punto, tra le informazioni pubblicate sul topic /tf, compaiono

la Tranform con frame id=ground truth e child frame id=base footprint e

quella con frame id=odom e child frame id=virtual base footprint, che con-

tengono, rispettivamente, la posizione dei robot ground truth e odom rispetto

alla posizione iniziale.

in Figura 8.5 si può notare la visualizzazione con rviz2 dei messaggi pub-

blicati su /tf. É visibile il centro della scena, a cui sono collegate le posizioni

iniziali dei robot (che coincidono) a cui a loro volta sono collegati tutti gli

elementi dell’albero di ciascun robot.

42



CAPITOLO 8. AGGIUNTA DELL’ODOMETRIA

Figura 8.4: Albero di transform visualizzato con rviz2

Figura 8.5: Visualizzazione di transform in rviz2
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Capitolo 9

Comunicazione tra Unity e

DDS

ROS 2 utilizza come middleware lo standard DDS. È quindi possibile utiliz-

zare un’implementazione di DDS per comunicare con l’ambiente ROS 2. In

questo modo, anziché scrivere programmi C++ che si appoggiano sulle libre-

rie di ROS 2 per scambiare informazioni e comandi con il robot simulato in

Unity, è possibile scrivere programmi, sempre in C++, che utilizzano le libre-

rie di un’implementazione del DDS, come eProsima fast DDS. Dal momento

che ROS 2 fornisce un’astrazione della comunicazione DDS, lo sforzo richie-

sto per implementare la comunicazione direttamente sfruttando eProsima è

maggiore, come si può capire confrontando le Figure 2.2 e 2.3.

Per implementare un semplice publisher o subscriber è possibile seguire la

documentazione di eProsima, al link https://fast-dds.docs.eprosima.c

om/en/v2.2.0/fastdds/getting started/simple app/simple app.html.

Per far s̀ı che i nodi implementati in eProsima comunichino con l’ambiente

ROS 2, è necessario che i nomi dei topic e i topic type nei due ambienti

siano compatibili. Per illustrare come ottenere questa compatibilità si farà

riferimento ad un esempio pratico, ovvero il topic /cmd vel, utilizzato per

comunicare comandi di velocità (lineare e angolare) al robot.

Per conoscere il nome del topic e il suo topic type si deve lanciare il server

endpoint.py dal terminale (si veda la sezione 4.1) e avviare la simulazione.
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A questo punto è possibile aprire un altro terminale e, dopo aver eseguito il

comando per il source di ROS 2, eseguire il comando:

$ ros2 t op i c l i s t −t

che lista tutti i topic attivi con i relativi topic type. Se lo script AGVCon-

troller.cs (si veda il Capitolo 5) è abilitato all’interno della simulazione, si

può individuare la seguente linea di testo:

/ cmd vel [ geometry msgs/msg/Twist ]

dove /cmd vel è appunto il nome del topic e geometry msgs/msg/Twist il

topic type. Twist è un type messo a disposizione da ROS 2 contenente due

vettori da tre elementi float64 ciascuno.

Ad ogni topic ROS 2 corrisponde un topic DDS il cui nome viene ottenuto

concatenando il prefisso rt con il nome del topic ROS 2. Nel programma che

implementa un nodo DDS non bisogna quindi settare il nome del topic come

/cmd vel, ma come rt/cmd vel.

In eProsima i topic type sono descritti in file IDL, utilizzati poi dal tool

Fast DDS-Gen, descritto nella sezione 2.3. Il file Twist.idl relativo a questo

esempio deve essere definito come segue:

#include "Vector3.idl"

module geometry_msgs {

module msg {

module dds_ {

struct Twist_ {

Vector3 linear;

Vector3 angular;

};

};

};

};

I primi due module e struct servono a replicare la struttura prevista da ROS

2: geometry msgs/msg/Twist. Si noti che module dds e l’underscore dopo

Twist non sono opzionali, ma servono per rendere compatibili i tipi di ROS
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2 ed eProsima DDS. Il type Vector3, non essendo utilizzato direttamente da

nessun nodo, può essere descritto in un file Vector3.idl più semplicemente:

struct Vector3 {

double x;

double y;

double z;

};

All’interno di ros unity sim, si veda l’Appendice B, è stato creato uno

workspace contenente due package: dds unity e dds tf. Il primo implementa

in maniera pressoché identica i programmi scritti sfruttando le librerie di ROS

2 e descritti nel Capitolo 5 (scan subscriber.cpp e cmd vel publisher.cpp) e

nel Capitolo 6 (image subscriber.cpp). L’unica differenza è che nel caso di

DDS, image subscriber.cpp salva in locale solamente le prime cinque im-

magini ricevute e le salva in ros unity sim/dds ws/dds unity. Nel package

dds tf, lo script tf subscriber.cpp registra un subscriber sul topic /tf. Sullo

stesso topic pubblica messaggi di tipo Tranform lo script ROSTransform-

TreePublisher.cs. Una volta ottenuto un messaggio, il programma stampa a

console solamente le informazioni riguardanti gorund truth e odom (si veda

il Capitolo 8).

I nodi implementati da scan subscriber.cpp e image subscriber.cpp ricevo-

no messaggi che contengono degli array. In eProsima, per far si che messaggi

contenenti array vengano sempre ricevuti correttamente, bisogna modificare

i QoS del DataReader. Questo perché la configurazione di default del Da-

taReader consente di ricevere messaggi contenenti array con al massimo 100

elementi, poiché ne alloca precedentemente lo spazio. Per far s̀ı che vengano

ricevuti correttamente array con un numero arbitrario di elementi, è necessa-

rio che il DataReader gestisca dinamicamente la memoria allocata agli array.

Per far ciò bisogna crearlo con i QoS corretti, come segue:

DataReaderQos readerQos;

readerQos.endpoint().history_memory_policy =

eprosima::fastrtps::rtps::DYNAMIC_RESERVE_MEMORY_MODE;
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reader_ = subscriber_->create_datareader(topic_,

readerQos, &listener_);

Per implementare nodi con publisher che devono pubblicare messaggi conte-

nenti array di lunghezza arbitraria si può adottare una soluzione del tutto

analoga durante la creazione del DataWriter. Per quanto riguarda la pub-

blicazione di messaggi, inoltre, bisogna prestare attenzione a non eliminare

il publisher immediatamente dopo aver pubblicato un messaggio. Infatti, in

questo caso, il messaggio viene effettivamente pubblicato correttamente e,

ad esempio, è possibile visualizzarlo con un comando di echo sul topic da

terminale, ma non viene ricevuto da Unity.
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Appendice A

Installazione ed uso

Per poter utilizzare il materiale contenuto nella cartella ros unity sim, de-

scritta nell’Appendice B, è necessario predisporre l’ambiente di lavoro instal-

lando localmente ROS 2, eProsima e Unity. Di seguito si forniscono le infor-

mazioni relative a come installare i software necessari sul sistema operativo

Ubuntu 20.04 LTS Focal Fossa.

• Per installare la distro Foxy Fitzroy di ROS 2 si devono seguire i passi

indicati nella documentazione ufficiale: https://docs.ros.org/en/

foxy/Installation/Alternatives/Ubuntu-Install-Binary.html.

• Analogamente, per eProsima Fast DDS 2.2.0 si può seguire la guida

all’installazione della documentazione, presente al link https://fast

-dds.docs.eprosima.com/en/v2.2.0/installation/binaries/bin

aries linux.html.

• Alcuni programmi utilizzano la libreria OpenCV per la gestione delle

immagini. Per installare questa libreria si segua la documentazione

ufficiale al link https://docs.opencv.org/4.x/d7/d9f/tutorial l

inux install.html.

• Per quanto riguarda Unity è necessario creare un account sul sito uffi-

ciale. Dopodiché si consiglia di installare l’Editor passando per Unity

Hub, che facilita la gestione dei progetti e delle versioni dell’Editor. La

guida per l’installazione di Unity Hub per Linux è disponibile al link
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https://docs.unity3d.com/hub/manual/InstallHub.html#ins

tall-hub-linux, nella sezione Debian or Ubuntu. Una volta aperto

Unity Hub, bisogna accedere con l’account creato in precedenza. A que-

sto punto è possibile scaricare la versione LTS dell’Editor più recente

andando in Installs→Official releases.

Inoltre, se si vogliono modificare i programmi contenuti nelle sottocartelle

ros ws e dds ws di ros unity sim, è necessario prima seguire i seguenti passi.

Per ros ws:

• eliminare le cartelle build, install e log;

• aprire una finestra del terminale ed eseguire il source del file di setup

di ROS 2;

• nella stessa finestra del terminale, navigare fino alla cartella ros ws ed

eseguire il comando:

$ co l con bu i ld

Per dds ws:

• eliminare il contenuto (e solo il contenuto) delle cartelle build nei pac-

kage dds unity e dds tf;

• in una finestra del terminale, per ogni package, navigare nella cartella

build ed eseguire i comandi:

$ cmake . .

$ make c l ean && make

A.1 Esempio d’uso

Per testare alcuni dei programmi ed il progetto Unity contenuti in ros unity sim

seguire i seguenti passi:
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• Aprire Unity Hub e navigare nella sezione Projects. Se unity project

non compare nella lista dei progetti, importarlo premendo il pulsante

Open e selezionando la cartella unity project in ros unity sim.

• Sempre nella sezione Projects di Unity Hub, aprire il progetto uni-

ty project.

• A questo punto si apre l’Editor di Unity. Nella finestra Project dell’E-

ditor navigare in Assets/Scenes e fare doppio click sul file Labs.

• Aprire un nuovo terminale ed eseguire il source del file di setup di ROS

2 e dello workspace ros ws e lanciare endpoint.py:

$ . ∼/ ro s2 f oxy / ros2−l i nux / setup . bash

$ . ∼/ r o s un i t y s im / ros ws / i n s t a l l / setup . bash

$ ros2 launch ro s t cp endpo in t endpoint . py

• Nell’Editor avviare la simulazione premendo il pulsante Play (nella

parte alta della finestra).

• Aprire un nuovo terminale ed eseguire il source del file di setup di ROS

2 e dello workspace ros ws ed eseguire cmd vel publisher:

$ . ∼/ ro s2 f oxy / ros2−l i nux / setup . bash

$ . ∼/ r o s un i t y s im / ros ws / i n s t a l l / setup . bash

$ ros2 run unity pub sub cmd ve l pub l i she r

Nella finestra dell’Editor il robot inizierà a muoversi.

• Aprire un nuovo terminale ed avviare l’eseguibile tf subscriber:

$ cd ∼/ r o s un i t y s im /dds ws/ dd s t f / bu i ld

$ . / t f s u b s c r i b e r

Nel terminale verranno stampare le informazioni riguardanti la posizio-

ne del robot e la sua odometria.
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Cartella ros unity sim

Di seguito vengono descritti gli elementi fondamentali contenuti nella cartella

ros unity sim.

La cartella ros ws è uno workspace ROS 2 contenente tre package: ROS-

TCP-Endpoint, unity slam example e unity pub sub. Il primo contiene i file

relativi al server endpoint descritto nella sezione 3.1; il secondo contiene lo

workspace fornito da Unity Technologies e relativo all’utilizzo di Unity per

la simulazione di TurtleBot3 con SLAM. il package unity pub sub contiene

tre programmi:

• cmd vel publisher.cpp: implementa un nodo ROS 2 che pubblica mes-

saggi sul topic /cmd vel con lo scopo di comandare il movimento del

robot. Il nome dell’eseguibile è cmd vel publisher;

• scan subscriber.cpp: implementa un nodo ROS 2 che riceve i messaggi

pubblicati sul topic /scan e stampa a terminale una parte del loro

contenuto. Il nome dell’eseguibile è scan subscriber;

• image subscriber.cpp: implementa un nodo ROS 2 che riceve i messaggi

pubblicati sul topic /image/compressed e salva in locale le immagini

ricevute. Il nome dell’eseguibile è image subscriber.

La cartella dds ws è uno workspace eProsima contenente due cartelle:

dds unity e dds tf. La prima contiene i file necessari a replicare il compor-

tamento dei tre programmi contenuti nel package unity pub sub di ros ws,
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ma attraverso eProsima fast DDS anziché ROS 2. I nomi dei file e i re-

lativi eseguibili sono uguali a quelli in ros ws. Il package dds tf contiene

tf subscriber.cpp che riceve messaggi sul topic /tf e stampa a terminale una

parte del loro contenuto. Il nome dell’eseguibile è tf subscriber. I file IDL

relativi ai messaggi scambiati da questi nodi (e quelli da essi generati da ePro-

sima Fast DDS-Gen) si trovano nelle rispettive cartelle src. Gli eseguibili si

trovano nelle cartelle build.

La cartella unity project è un progetto Unity. È possibile navigare i con-

tenuti di questa cartella direttamente dall’Editor di Unity. Nella cartella

Packages sono contenuti i riferimenti a tutti i package importati nel pro-

getto, come ROS TCP Connector (si veda la sezione 3.2). All’interno di

Assets si trovano file di varia natura utilizzati all’interno della simulazione,

sia creati all’interno dell’Editor, che importati, ad esempio dall’Unity Asset

Store. In Assets ci sono file quali i materials, le scene e gli script (si veda

la sezione 2.1). Le scene sono tre: SimpleWarehouseScene viene fornita da

UnityTechnologies, SlipScene permette di verificare il funzionamento di zone

scivolose e Labs è un esempio di simulazione di un ambiente reale, ovvero

alcuni laboratori del dipartimento di Ingegneria dell’Università degli Studi di

Bergamo. Il modello del robot in SimpleWarehouseScene è quello originale

fornito da Unity Technologies, mentre i modelli nelle altre due scene sono

stati ampiamente modificati, come descritto nei Capitoli 6, 7 e 8. I file con-

tenuti direttamente nella cartella Scripts sono forniti da Unity Technologies,

mentre quelli nelle sottocartelle myControllers e myRGBCamera sono stati

implementati, rispettivamente, per modificare la modalità con cui si fa muo-

vere il robot (si veda il Capitolo 7) e per implementare un nuovo sensore,

ovvero una camera (si veda il Capitolo 6).

Nella pagina seguente vengono illustrati, all’interno dell’albero della car-

tella ros unity sim, gli elementi appena descritti. L’albero non è completo di

tutti i file e cartelle ma mostra la struttura generale e gli elementi di maggiore

interesse.
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ros unity sim

ros ws

build

install

log

src

ROS-TCP-Endpoint

unity pub sub

src

image subscriber.cpp

scan subscriber.cpp

cmd vel publisher.cpp

unity slam example

dds ws

dds tf

build

src

tf subscriber.cpp

CMakeLists.txt

dds unity

build

src

image subscriber.cpp

scan subscriber.cpp

cmd vel publisher.cpp

CMakeLists.txt

unity project

Assets

Scenes

SimpleWarehouseScene.unity

SlipScene.unity

Labs.unity

Scripts

myControllers

myRGBCamera

...

...

Packages
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